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FAHControl : l’interface de gestion du Client 
Folding@home  
En abrégé FAHControl. C’est un nouvel interface graphique utilisateur (GUI : Graphical 
User Interface en anglais) qui est utilisé pour contrôler les clients console V7. Il gérera 
les slots présents. FAHControl a trois modes de fonctionnement qui sont les suivants :  

• « Novice » 

o Pour les nouveaux donateurs de F@h. Il procure un simple interface qui 
affiche toutes les informations nécessaires d’une manière très 
compréhensible. Notez que le mode « Novice » ne permet que le contrôle de 
slots locaux. Pour le contrôle de slots à distance, vous devrez choisir un des 
modes décrit ci-dessous.  

• « Advanced » 

o Ce mode est destiné aux Enthousiastes de F@h qui voudront avoir des 
informations complémentaires concernant leurs slots.  

• « Expert » 

o Ce mode est destiné aux Gourous de F@h et procure des mises au point qui 
ne doivent  être changées que si l’utilisateur est absolument sure de ce qu’il 
fait. Ne changez pas des valeurs sans savoir ce que vous faites.  

• Chaque mode contient les information du mode précédent plus des informations 
complémentaires cachées dans le mode précédent. Vous pouvez changer de 
mode en choisissant le mode approprié à partir de la liste déroulante se trouvant 
en haut à droite de l’écran avant le bouton « About » (Au sujet de).  

1 Mode « Novice » 
Ce mode convient pour les nouveaux membres de F@h ou des membres qui désirent 
seulement avoir un interface simple lui donnant des informations de base. C’est le mode 
par défaut lorsque vous installez FAHControl. Il donnera des options limitées pour 
configurer le slot. Elles sont accessibles au moyen du bouton « Configure » en haut à 
gauche de l’écran :  

• « Connection » (Connexion) 
• « Identity » (Identité) 
• « Proxy » 

Chaque onglet de configuration sera brièvement décrit ci-dessous. 

1.1. Ecran principal 
Ci-dessous l’écran principal de FAHControl.  
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1.1.1. La barre supérieure des boutons 

• « Configure »  Configuration des slots. 
• « Preferences »  Préférences, consulter le paragraphe « Préférence ». 
• « Fold »  Démarrage du calcul (WU) attribué à chaque slot présent. 
• « Pause »  Mise en pause des slots présents. 
• « Finish »  Termine les calculs en cours dans les slots, envoie les 

calculs et met en pause tous les slots. 
• « Viewer »  Consulter le paragraphe « La visionneuse ».  
• « Hide »  Placer FAHControl dans la zone de notification. 
• « Quit »  Arrêter tous les slots et fermer la  fenêtre FAHControl. 
• « Mode »  une liste déroulante où vous pouvez choisir l’interface 

utilisateur de FAHControl. 
• « About »  Consulter ce paragraphe. 

1.1.2. La ligne « Identity » (Identité) 
• « Name » Le pseudo F@h de l’utilisateur mis dans la configuration du 

slot. En cliquant dessus vous ouvrirez la page de vos statistiques chez 
Standford.  

• « Team »  Le numéro du team F@h mis dans la configuration du slot. 
En cliquant dessus vous ouvrirez la page des statistiques de votre team 
chez Standford.  

Ces données peuvent être modifiées via le bouton « Configure » et en suite 
l’onglet « Identity ».  

1.1.3. Le tableau « Work Queue » (La file de travail)  
Ce tableau contient les informations suivantes : 
• « ID »  La position dans la file du calcul (WU) en cours.  
• « Status »  Le statut du calcul (WU) qui peut être le suivant :  

o « Running »  Le calcul plie.  
o « Ready »  Le calcul est prêt à plier (il ne plie pas encore).  
o « Download »  Téléchargement du calcul.  
o « Send »  Envoi du calcul vers le serveur.  
o « Stopping »  Le « FahCore » a envoyé un signal de fin de 

calcul et s’arrêtera endéans les 60 secondes ou moins suivant la 
configuration par défaut.  

o « Failed »  Le slot a rencontré une sérieuse erreur et s’est arrêté 
de plier. L’intervention de l’utilisateur est requise.  

• « Progress »  Une barre d’avancement, graduée en 0.01%, indique 
l’état du calcul.  

• « ETA »  Le temps restant pour terminer le calcul.  
• « Credit » Le nombre de points attribué au calcul. (lisez la Note 1)  
• « PRCG »  L’identification du calcul : « Project Run Clone 

Generation ».  
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Note 1: Afin que cette caractéristique fonctionne, il faut que le serveur dont 
dépend le calcul aie les derniers codes. Si ce n’est pas le cas, la valeur 
« unknown » (inconnu) sera affiché. Ce n’est pas une erreur. Les codes des 
serveurs de travail seront mis à jour au fur et à mesure afin de supporter cette 
caractéristique.  

1.1.4. La ligne « About Project » (Description du projet) 
Vous y trouverez la description du projet en cours de pliage 

1.2. Le bouton « Configure » (Configurer) 
En cliquant sur le bouton « Configure » (Configurer), une nouvelle fenêtre s’ouvre 
munie des onglets suivants :  
1.2.1. L’onglet « Connection » (Connexion) 

En cliquant sur l’onglet « Connection », la vue ci-dessous s’ouvre.  

 
Cette vue contient les informations suivantes :  

• « Name »  Ce n’est pas votre pseudo. C’est le nom donné au slot.  
• « Address »  L’adresse IP et le numéro du port du slot. Ils peuvent 

être maintenus à leur valeur par défaut.  
• « Password »  Mot de passe pour l’accès à « FAHControl ».  
• « Local Client »  Bouton vous permettant d’arrêter/démarrer le(s) 

slot(s) sans quitter « FAHControl ».  

1.2.2. Onglet « Identity » (Identité) 
Cet onglet vous permet de changer vos données personnelles de membre  
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Vous y trouvez les informations suivantes : 

• « Name »  Votre pseudo de membre F@h. Par défaut, il est 
« anonymous ». 

• « Team number »  Le numéro du team F@h que vous avez rejoint. 
Par défaut, il a le numéro 0 

• « Passkey »  Le « Passkey » peut être considéré comme un mot de 
passe rattaché à votre pseudo. Un Passkey est requis seulement pour 
obtenir des bonus de points sur certains projets F@h. Il est optionnel 
et est recommandé pour des raisons de sécurité. Pour des détails, 
consulter le paragraphe le concernant ci-dessous.  

1.2.3. L’onglet « Proxy » 

 
Si votre ordinateur est derrière un proxy, cela vous permet de le configurer. 
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Pour en faire la configuration, vous devez d’abord activer la fenêtre en 
cochant la case « Enable proxy configuration ».(Permettre la configuration 
du proxy) La fenêtre étant activée, vous devez remplir les informations 
suivantes : 

• « Proxy »  Mettre le « Hostname » (nom du serveur) ou 
l’adresse IP, et le port 

• « Proxy Authentification  Votre identification sur le serveur si 
nécessaire en remplissant les cases suivantes : 

o « Name »  Votre nom  
o « Password »  Votre mot de passe  
o « Reenter » Remettre le mot de passe  

Si le voyant vert s’allume, c’est que vos deux mots de passe 
concordent et dès lors vous sauvegarder la configuration en 
cliquant sur le bouton « Save ».(Sauver) 

1.3. Le bouton « Preferences » (Préférences) 
Il permet de configurer FAHControl. Cette configuration reste la même pour les trois 
modes « Novice/Advance/Expert ».  

 
1.3.1. Options « Startup & Shutdown » (Démarrage et Arrêt) 

• « Start minimized »  Réduction de la taille de la fenêtre de FAHControl. 
Par défaut, la case n’est pas cochée ainsi FAHControl démarrera en taille 
normale si l’icône du bureau est cliquée.  

• « Quit on window close »  Quitter à la fermeture de la fenêtre. Par 
défaut la case n’est pas cochée et la fenêtre sera réduite dans la zone de 
notification. Attention si vous cochez la case, le slot s’arrêtera de plier. 

1.3.2. Options « Local Client » (Client local) 

• « Autostart »  Démarrage automatique du slot à l’ouverture de 
FAHControl. Par défaut, la case est cochée afin que FAHControl démarre 
automatiquement le slot. Il est recommandé de laisser cette case cochée.  

• « Command »  Instruction à mettre pour gérer le démarrage de 
FAHClient.  

1.3.3. Options Visualization (Visualisation) 

https://fah-web.stanford.edu/projects/FAHClient/attachment/wiki/FahControl/0-Preferences.PNG
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Cette partie concerne la visionneuse. Consultez le paragraphe « Configuration 
de la visionneuse ». 

1.4. Le bouton « About » (Au sujet de) 
Ce bouton ouvrira une fenêtre vous donnant les informations concernant la version 
V7 installée et des détails additionnels concernant la conception de la version V7.  

 
2 Mode « Advanced » 

Ce mode aidera les utilisateurs qui désirent visionner des données complémentaires et 
qui ont assez de connaissance pour configurer le slot ou ajouter des slots avec une 
relative facilité en se servant des nouveaux onglets liés au bouton « Configure » 
(Configurer), onglets complémentaires qui sont les suivants :  

• « Slots »  
• « Advanced » (Avancé) 

Ces nouveaux onglets seront décrits ci-dessous. 

2.1. Ecran principal 
L’écran principal permet de visionner des données complémentaires et est le même 
que le mode « Expert ». Ce mode a des onglets complémentaires qui seront décrits 
ci-dessous.  
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2.1.1. Le tableau « Clients » 

Il se trouve à gauche de l’écran.  

Ce tableau contient les informations suivantes :  
• « Name »  Le nom du slot.  
• « Status »  Le statut du slot.  

o « Online » le slot est en fonctionnement.  
o « Offline »  le slot est à l’arrêt.  
o « Updating »  le slot est en phase de mise à jour.  
o « Connecting » le slot essaie de se connecter.  

• « Address »  L’adresse IP de du slot  

A partir de ce tableau, vous pouvez ajouter ou supprimer un slot à distance. 
Cela dépend de votre choix. 

En cliquant sur le bouton « Add » (Ajouter), la fenêtre ci-dessous apparaîtra.  
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Cette vue contient l’onglet « Client Connection » (Connexion du client) où 
vous trouverez les informations suivantes :  

• « Name »  Ce n’est pas votre pseudo de membre F@h mais c’est le 
nom donner au FAHControl  

• « Address »  L’adresse IP et le numéro du port du FAHControl local.  
• « Password »  Un mot de passe que vous pouvez mettre pour 

limiter l’accès à « FAHControl ».  
• « Local Client »  Bouton vous permettant d’arrêter/démarrer le(s) 

slot(s) sans quitter « FAHControl ». 

2.1.2. Le tableau « Client » 
Ce tableau contient les onglets suivants : 

• L’onglet « Status » (Statut) donne des informations concernant le statut de 
votre client. 

• L’onglet « System Info » (Information système) donne des informations 
concernant FAHControl et votre ordinateur. 

• L’onglet « Log » (Historique) vous donne l’historique du slot.  

2.1.2.1. L’onglet « Status » 

• La ligne « Identity » (Identité) contient les informations suivantes :  

o « Name »  Votre pseudo de membre F@h. En cliquant dessus, 
vous ouvrirez votre page personnelle de statistiques chez 
Standford.  

o « Team »  Le numéro de votre team F@h. En cliquant dessus, 
vous ouvrirez la page des statistiques de votre team d’un des sites 
que vous aurez choisi au moyen de la liste déroulante. Vous aurez 
le choix entre les sites suivants :  

 « Folding@home »  Le site des statistiques officielles de 
Standford qui est le site par défaut.  

 « Extreme Overclocking ».  
 « Kakao Stats .  
 « [H]ard » Folding.  

• La ligne « Folding slots » (Slots en pliage) contient les informations 
suivantes :  

o « ID »  Le numéro du slot. Il démarre avec le numéro 0  
o « Status » (Statut)  L’Information sur l’état du slot qui peut être :  

 « Running » (En service)  Le slot plie un calcul (WU).  
 « Paused » (En pause)  Le slot est mis en  pause.  
 « Finishing » (Fin)  Le slot termine le calcul (WU), envoie 

le résultat et se met en pause.  
 « Ready » (Prêt)  Le slot est soit en envoi soit en 

téléchargement d’un calcul (WU).  
 « Stopping » Arrêt)  Le « FahCore » a envoyé un signal 

de fin d’exécution et s’arrêtera endéans les 60 secondes ou 
moins suivant la configuration par défaut.  

 « Failed » (En défaut)  Le slot a rencontré une sérieuse 
erreur et s’est arrêté de plier. Une intervention de 
l’utilisateur est requise.  

o « Description » (Description)  Le type de client F@h attribué au 
slot. Il peut être :  
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 « Uniprocessor » (Simple processeur)  Le slot pliera des 
calculs (Wu’s) dédiés à un simple processeur.  

 « SMP »  Le slot pliera des calculs (WUs) dédiés à des 
processeurs multi cœur. 

 « GPU »  Le slot pliera des calculs (WUs) dédiés aux 
processeurs de carte graphique, si la carte le permet.  

En faisant un clique droit sur la ligne du slot, un menu apparaîtra :  

 
Vous aurez les options suivantes : 

o « Fold » (Plier)  Démarre tous les slots. 
o « Pause »  Met en pause tous les slots. 
o « Finish » (Terminer)  Donnera l’ordre de terminer les calculs 

(WU) en cours dans tous les slots, d’envoyer les résultats et de 
mettre en pause tous les slots  

o « Viewer » (Visionneuse)  Consultez le paragraphe « La 
visionneuse ».  

• La ligne « Work Queue » (File de travail) contient les informations 
suivantes :  

o « ID »  Le numéro du calcul (WU) en cours de pliage dans la file.  
o « Status »  Le statut du calcul (WU) pouvant être :  

 « Running »  Le calcul (WU) est en service.  
 « Ready »  Le calcul (WU) est prêt à plier mais ne plie 

pas encore.  
 « Download  Le calcul (WU) est en téléchargement.  
 « Send »  Le résultat du calcul (WU) est à l’envoi vers le 

serveur.  
 « Update Core »  Le calcul (WU) assigné nécessite la 

dernière version du FahCore qui est téléchargé 
automatiquement.  

o « Progress »  Une barre d’état d’avancement avec une précision 
proche de 0.01%, indique la progression du calcul (WU) en cours.  

o « ETA »  Le temps estimé pour terminer le calcul (WU).  
o « Credit »  Les points qui seront attribués au calcul (WU) en 

cours. (consultez la note 2 ci-dessous).  
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o « PRCG »  Les caractéristiques du calcul (WU) en cours (Project 
Run Clone Generation).  

• Le tableau « Work Unit » (Le calcul) contient les informations suivantes :  

o « PRCG »  Les caractéristiques du calcul (WU) en cours (Project 
W Run X Clone Y Gen Z).  

o « Folding Slot ID »  L’ID du slot en service.  
o Queue ID  Le numéro dans la file du calcul (WU) en cours de 

pliage.   
o « Status »Le statut du calcul (WU) en cours qui peut être :  

 « Running »  Le calcul (WU) est en pliage.  
 « Ready »  Le calcul (WU) est prêt à plier mais il ne plie 

pas encore.  
 « Done »  Le calcul (WU) a atteint 100%.  
 « Send »  Les résultats du calcul (WU) sont à l’envoi.  
 « Download »  Téléchargement d’un calcul (WU).  
 « Update Core »  Le calcul (WU) assigné nécessite la 

dernière version du FahCore qui est téléchargé 
automatiquement.  

o « Progress »  Une barre d’avancement, au 0.01%, indique la 
progression du calcul (WU) en cours.  

o « ETA »  Le temps estimé pour terminer le calcul (WU).  
o « Base Credit »  Les points de base alloué au calcul (WU), cette 

information a deux différentes significations :  
 « Bonus WUs »  Pour des calculs avec bonus, les points 

de base augmenteront exponentiellement au plus vite le 
calcul est rentré (consultez la note 3 ci dessous).  

 Non Bonus WUs  Pour des calculs sans bonus, ce sont 
les points que vous recevrez si vous avez renvoyé le calcul 
(WU) avant la date d’expiration.  

o « Estimated Credit »  Donne les point alloués à ce calcul (WU) 
(consultez la note 2 ci-dessous).  

o « Estimated PPD »  Donne une estimation des points par jour 
en supposant que le slot tourne 24/7 pour des calculs (WUs) issus 
du même projet (consultez la note 2 ci-dessous).  

o Estimated TPF -> Donne le temps pour calculer 1 « frame », ce 
qui représente 1% du calcul (WU).  

o « Project »  Le numéro du projet auquel le calcul (WU) 
appartient. En cliquant dessus vous ouvrirez la page de la 
description du projet. Attention, en visitant trop souvent ce site, 
votre adresse IP peut être bannie.  

o « FahCore »  Le « FahCore » nécessaire pour plier le calcul 
(WU) assigné.  

o « Waiting On »  Le calcul (WU) est en attente d’une opération 
qui peut être la suivante :  

 « Send results »  le slot attend que le calcul (WU) soit 
envoyé.  

 « FahCore run »  En attente que le « FahCore » démarre 
le pliage du calcul (WU).  

 « WS Assignment »  Le slot attend de recevoir son 
assignement à un serveur de travail approprié afin de 
recevoir un calcul (WU) à plier  

o « Attempts »  Le nombre de tentatives pour réaliser une des 
opérations décrites ci-dessus.  

o « Next Attemp »t  Le temps qu’il faudra pour exécuter une 
nouvelle tentative d’une des opérations décrites ci-dessus.  
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o « Assigned »  La date et l’heure d’assignement du nouveau 
calcul (WU) à votre ordinateur.  

o « Timeout »  La date et l’heure où le calcul (WU) sera réassigné 
à un autre membre et que vous perdrez l’avantage d’avoir un 
bonus de points pour ce calcul (WU). (consultez la note 2)  

o « Expiration »  La date et l’heure où le calcul ( W)U sera 
supprimée de votre ordinateur et que vous ne recevrez aucun point 
pour celui-ci.  

o « Work Server »  L’adresse IP du serveur d’où provient le calcul 
(WU) et où il enverra en premier les résultats. En cliquant dessus, 
vous ouvrirez la page de l’historique du serveur. Soyez vigilant car 
il chargera beaucoup d’informations.  

o Collection Server  Si il est défini, c’est le serveur de secours. 
Celui-ci prendra le relai lors d’un envoi si le serveur de travail 
assigné n’est pas joignable. Si il n’est pas défini, il sera affiché à 
l’écran 0.0.0.0. En cliquant dessus, vous ouvrirez la page de 
l’historique du serveur. Soyez vigilant car il chargera beaucoup 
d’informations.  

o « Unit ID » -> C’est l’unique ID du calcul (WU) pour le projet 
Folding@home.  

Note 2 : Afin que cette fonction travaille, le serveur de travail doit avoir les dernier codes. 
Si il ne les possède pas la valeur « unknown » (inconnu) sera affiché. Ne soyez pas 
troublé pour l’instant. Dans le future, tous les codes des serveurs de travail seront mis à 
jour pour supporter cette fonction.  

Note 3 : Tout les calculs (WUs) assignés n’ont pas un bonus de points. Pour l’instant, les 
calculs (WUs) avec bonus ne sont seulement disponibles que pour certains projets. Afin 
de tirer parti de cet avantage, vous devez être qualifié (consultez « Qualification d’un 
membre »). Les projets supportant le bonus de points sont identifiés par une valeur 
supérieure à 0 dans la colonne « Kfactor » de la page Project Summary (c’est la dernière 
colonne à l’extrême droite).  

Qualification d’un membre (Passkey) 

1. Utilisez le dernier client SMP (v6.29 ou supérieur). 
2. Configurez le client avec un « passkey ». 
3. Terminez 10 calculs utilisant le FAHCore A3, A4 ou A5. 

a. endéans le temps préféré 
b. utilisez la même association « passkey » et pseudo 
c. sur un ou plusieurs de vos ordinateurs 

4. Renvoyer un calcul complet dans un temps ≥ à 80% du temps assigné. 
  

http://fah-web.stanford.edu/psummary.html
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2.1.2.2. L’onglet « System Info » (Information système) 
Cet onglet donnent des information concernant « FAHControl » et l’ordinateur où 
il est installé.  

 
Voici un bref descriptif des informations si trouvant :  

• « Folding@home Client »  Les informations concernant le développeur 
et l’emplacement des fichiers de configuration des clients.  

• « Build »  Les informations concernant la version de « FAHControl » 
que vous utilisez.  

• « System »  Les information concernant l’ordinateur où FAHControl est 
installé.  

2.1.2.3. L’onglet « Log » (Historique) 
Cette onglet permet au membre de visionner l’historique depuis que le client a 
démarré.  

 
Vous trouverez à droite deux boutons dont la signification est la suivante : 
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• Le bouton « Clear »  Il efface les données de l’historique.  
• Le bouton « Refresh » -> Il rafraichi l’historique en rechargeant tous le 

fichier.  

Par un clique droit sur le texte, un menu apparaîtra :  

 
Seulement, les options suivantes sont disponibles : 

• « Copy »  Permet de copier un texte sélectionné dans le cache de telle 
manière de pouvoir le copier n’importe où. Vous pouvez utiliser le 
raccourci « Crtl+C » 

• « Select All »  Permet de mettre en surbrillance tout l’historique. Vous 
pouvez utiliser le raccourci « Crtl+A » 

2.2. Le bouton « Configure » (Configurer) 
Par rapport au mode « Novice », vous aurez les onglets additionnels suivants :  
2.2.1. L’onglet « Slots » 

Le slot est une nouvelle notion introduite dans « FAHControl ». Chaque slot 
est un client F@H qui peut être configuré en fonction des préférences du 
membre. 
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La liste des slots en service seront visibles sur cette vue. Vous pouvez ajouter 
des slots complémentaires si votre ordinateur le permet en cliquant sur le 
bouton « Add » (Ajouter).  

Il y a trois types de slots :  

• « Uniprocessor »  Mode simple processeur/cœur. Il est utilisé 
pour les processeurs simple cœur ou multi cœur mais pour ce 
dernier il ne travaillera que sur un cœur. Il utilises peu de 
ressources système.  

• « SMP »  Mode processeur multi cœur. Il faut au minimum un 
processeur 2 cœurs. Il utilises assez bien de ressources système. 
La gestion de ce slot dépend de certains facteurs 
complémentaires.  

• « GPU »  Mode processeur de carte graphique (GPU). Il plie en 
utilisant le processeur  de la carte graphique. Il utilises assez bien 
de ressources système. La gestion de ce slot dépend de certains 
facteurs complémentaires.  

Des options complémentaires peuvent être ajoutées mais seulement par des 
membres qui savent ce qu’ils font. 

2.2.2. L’onglet « Advanced » 
Ce onglet vous permet de régler certaines configurations pour tous les slots 
présents. Cela suppose que le membre connait parfaitement le 
fonctionnement d’un slot. Ci-dessous vous trouverez la vue de l’onglet «  
Advanced » 
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Vous y trouverez les informations suivantes : 

• « FahCore Priority »  La priorité pour le « FahCore ». Il y a deux 
possibilités. 

o « Lowerest possible »  La priorité plus petite possible 
qui est recommandée. 

o « Slightly higher »  Une priorité un peu plus haute. 

Vous laisser la configuration par défaut sauf dans le cas où un 
autre logiciel de calcul distribué bloque Fokding@Home. Dans ce 
cas vous cochez l’option « Slightly higher ». 

• « Percent CPU usage »  Le pourcentage de processeur utilisé. 
Vous avez la possibilité de modifier ce pourcentage si vous 
rencontrez des problèmes avec votre ordinateur. Un pourcentage 
de 100 % est recommandé. Attention, en diminuant ce 
pourcentage, vous allongez le temps pour terminer le calcul et 
vous risquez d’envoyer le calcul en dehors des délais. 

• « Checkpointing frequency »  La fréquence des sauvegardes. 
Vous pouvez modifier la fréquence de vos sauvegardes si vous le 
désirez. Une fréquence de sauvegarde de 15 min est 
recommandée. 

• « Optimizations » Optimisation du slot. Deux modifications sont 
possibles. 

o « Disable highly optimized assembly code »  Mettre 
hors service les codes assembleur d’optimisation. Case à 
ne cocher que si le FahCore s’arrête après une mauvaise 
instruction ou qu’on vous le demande. 
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o « Try to lock cores to a specific CPU »  Essayer de 
dédier le FahCore à un processeur 

 

3 Le mode « Expert » 
Ce mode permet d’avoir des options complémentaire de configuration et ne doit être 
utilisé que par des membres chevronnés de F@h. Les onglets additionnels sont les 
suivant :  

• « Remote Access »  Accès à distance  
• « Expert »  Des options spécifiques au mode « Expert »  

Ces onglets sont brièvement décrits ci-dessous. Tout changement fait à partir de ces 
deux nouveaux onglets peut avoir des effets défavorables dans le comportement du slot. 
3.1. L’onglet « Remote Access » 

Cet onglet permet de configurer « FAHControl » pour un contrôle à distance. 
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3.2. L’onglet « Expert » 
Vous ne ferez des changements ici que si un membre de l’équipe de Stanford vous 
le demande expressément. Soyez très prudent en faisant ces changements.  

 
La partie gauche sert pour des configurations additionnelles pour les slots. 
Ces configurations seront globales, i.e. elles affecteront tous les slots du 
FAHControl local. 

La partie droite sert à des configurations additionnelles pour le FahCore.  

En cliquant sur le bouton « Add » sous « Extra client options », vous 
ouvrirez la fenêtre ci-dessous vous permettant d’en réaliser la configuration.  

 

En cliquant sur le bouton « Add » sous « Extra core options », vous ouvrirez 
la fenêtre ci-dessous vous permettant d’en réaliser la configuration.  

https://fah-web.stanford.edu/projects/FAHClient/attachment/wiki/FahControl/3-Expert-Configure-Expert-ExtraClientOptions-Add.PNG


20 

 

 
 

4 Personnalisation du slot (client) – Ajouter des options (Flags  Mode 
Advanced ou Expert)  
Ce paragraphe décrit comment ajouter une ou plusieurs options à un slot, connues sous 
le nom de « flags ». Cette procédure suppose des connaissance expertes du logiciel 
Folding@home V7 et d’être familiarisé avec la liste de conversions des flags entre la 
version V6 et V7.  
Attention, une configuration incorrecte peut rendre le slot instable ou causer des 
résultats inattendus. 
Note : Ces options peuvent être ajoutées manuellement en éditant le fichier de 
configuration du client mais il y a des risques d’avoir une configuration incorrecte ou des 
fautes de frappe qui peuvent causer la suppression du calcul en cours ou le crash du 
client ou le crédit de points à un autre membre que vous.  

La  procédure recommandée est de travailler au moyen de la vue « Configure » 
(Configuration) de « FAHControl ». 

4.1. Procédure  
a. Ouvrez « FAHControl » et choisissez le mode « Advanced » ou « Expert » si 

ce n’est déjà fait (figure 1). Cela ne fonctionnera pas en mode « Novice ». 

 
Figure 1 

Cliquez sur le bouton « Configure » (Configuration) (figure 2) 

https://fah-web.stanford.edu/projects/FAHClient/attachment/wiki/FahControl/3-Expert-Configure-Expert-ExtraCoreOptions-Add.PNG
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Figure 2 

La fenêtre « Configure » apparait (figure 3).  

 
Figure 3 

b. Sélectionnez l’onglet « Slots », puis dans « Folding slots » (Slot de pliage) 
cliquez sur le slot pour le mettre en surbrillance et cliquez enfin sur le bouton 
« Edit » (Edition) (figure 4). 
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Figure 4 

c. La vue « Configure folding slot » (Configuration du slot) apparait où le type de 
slot est déjà sélectionné et vous cliquez sur le bouton « Add » (Ajouter) (figure 
5) 

 
Figure 5 

d. La vue « Edit Options » (Edition des options) apparait (figure 6). 
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Figure 6 

Entrez dans « Name » (Nom de l’options) et dans « Value » (Valeur) la valeur 
de l’options. Pour connaître les noms et les valeurs des options, consultez les 
tableaux ci-dessous, ainsi que le tableau de comparaison entre la version V6 
et V7  
Note : Les options entre la version v6 et V7 sont DIFFERENTES. Soyez sûre 
d’entrer la correcte option. 

Tableau des flags configurés par défaut  

Nom  Valeur par 
défaut  

Description 

client-type  normal  Pliage de calculs normaux 

max-packet-
size  normal  Téléchargement de calculs normaux (~10MB) 

core-priority  idle  Priorité « idle » pour FAHCore. 

next-unit-
percentage  99  

Téléchargement du calcul suivant lorsque le 
calcul en cours a atteint 99 pourcent de son 
pliage. 

max-units  0  Le nombre de calculs terminés ne mettra pas en 
pause le slot, car sa valeur est 0. 

checkpoint  15  Intervalle entre les sauvegardes du calcul en 
cours X est mis 15 minutes. 

pause-on-start  false  FAHControl ne démarrera jamais les slots en 
mode pause. 

Tableau des flags les plus communément utilisés  

Nom  Valeur  Valeur V6 Description  

client-
type  advanced  advmethods Pliage de calculs en phase bêta.  
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client-
type  bigadv  bigadv Pliage de gros calculs si votre ordinateur le 

permet.  

max-
packet-
size  

small  
Configuration 
interne du 
client 

Téléchargement de petits calculs (~5MB)  

max-
packet-
size  

normal  
Configuration 
interne du 
client 

Téléchargement de calculs normaux 
(~10MB)  

max-
packet-
size  

big  
Configuration 
interne du 
client 

Téléchargement des gros calculs (~500MB)  

core-
priority  idle  

Configuration 
interne du 
client 

Priorité « idle » pour FAHCore.  

core-
priority  low  

Configuration 
interne du 
client 

Priorité « low » pour FAHCore. 

Tableau des flags rarement modifiés par rapport à la configuration par défaut  

Name  Value  Description  

next-unit-
percentage  X  

X doit être compris entre 90 et 100. Il permet de télécharger 
le calcul suivant lorsque le calcul en cours a atteint X 
pourcent de son pliage.  

max-units  X  
X peut être n’importe quel nombre. Il permet de mettre en 
pause le slot après que X calculs ont été terminés. La 
valeur 0 indique pas de pause 

checkpoint  X  Intervalle entre les sauvegardes du calcul en cours. X est 
une valeur comprise entre 3 et 30 minutes.  

pause-on-start  true  FAHControl démarrera les slots en mode pause. Valeur 
« True » ou « False 

pause-on-start  false  FAHControl démarrera les slots normalement. Valeur 
« True » ou False » 

gpu-vendor-id  X  X est le type de carte graphique donnée par le fournisseur  

gpu-device-id  X  X is the DeviceID of the GPU.  
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Liste de l’équivalence des flags entre la version 6 et la version 7. 

v6 Option  v7 Option  v7 Notes  

-config  --configure  --config <filename> est utilisé dans le core 
v7 pour atteindre le fichier de configuration.  

-configonly  --configure  --configure arrête toujours le client.  

-help  --help  
 

-queueinfo  --queue-info  v7.0.7+  

-delete 
<number | 'x'>  

--dump <number | 
'all'>  

v7.0.7+, un calcul ne peut être supprimé 
tant qu’il n’a pas été envoyé.  

-send <number 
| 'x'>  --send  v7.0.7+,l’envoi d’un calcul spécifique n’est 

pas supporté  

-verbosity 
<number>  

--verbosity 
<number>   

-pause  --finish  
v7.0.7+, Termine les calculs en cours dans 
les slots, envoie les calculs et met en pause 
tous les slots.  

-oneunit  --max-units=1  v7.0.7+  

-forceasm  --extra-core-args=-
forceasm  

Tout argument supplémentaire pour le core 
peut être mis avec la fonction suivante 
extra-core-args.  

-advmethods  --client-
type=advanced   

-bigbeta  --client-
type=bigbeta  v7.0.7+  

-bigadv  --client-type=bigadv  v7.0.7+  

-betateam  --client-type=beta  
 

-internal  --client-
type=internal   

-gpu <number>  --gpu-id <number>  
 

-service  --service  
 



26 

 

-freeBSD  
--core-
prep="brandelf -t 
Linux"  

v7.0.7+  

-openBSD  --core-prep="elf2olf 
-o Linux"  v7.0.7+  

-smp 
<number>  

--smp --cpus 
<number>   

-threads 
<number>  --cpus <number>  Le client v7 détectera le nombre de cœurs 

par défaut.  

-forcegpu 
<type>  

--gpu --gpu-species 
<type>   

-nice 
<number>  --priority <number>  nice fonctionne aussi comme un alias de 

priority  

-license  --license  
 

-art  Pas supporté 
 

-local  Pas supporté 
 

-svcstart  Pas supporté 
 

-d <path>  Pas supporté 
 

-deino  Pas supporté 
 

Après avoir entré le nom et la valeur, vous cliquez sur le bouton « OK » et 
vous revenez à la vue « Configure folding slot » (Configuration du slot de 
pliage). Vous noterez que la nouvelle option apparait dans la fenêtre « Extra 
slot options » (Options supplémentaire pour le slot) (figure 7).  
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Figure 7 

e. Vous cliquez sur le bouton « OK » et vous revenez à la vue de l’onglet « Slots » 
(figure 8) et vous cliquez sur le bouton « Save » (Sauver) pour enregistrer les 
modifications. 

 
Figure 8 

f. Cette nouvelle configuration est reprise dans l’historique que vous pouvez 
visionné en cliquant sur l’onglet « Log » dans la vue principale (figure 9). 
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Figure 9 

g. De la même manière, vous pouvez ajouter d’autres options qui se retrouveront 
dans l’historique (figure10) 

 
Figure 10 
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5 Ajout de slots (Advanced ou Expert) 
Cette section décrit comment ajouter un ou plusieurs « slots » (client). Cette procédure 
présume d’avoir des connaissances expertes en Windows et en le logiciel 
Folding@home V7. Une première installation est sensée être faite et au moins un slot 
client est en service et sauf disposition contraire que les paramètres par défaut ont été 
configurés pour chaque option. 
Note: Des nouveaux slots peuvent être ajoutés manuellement en éditant le fichier de 
configuration du client. Cependant, c'est risqué à cause de configurations incorrectes ou 
d’erreurs de frappes pouvant causer l’arrêt prématuré de l'unité de travail en cours, l’arrêt 
brutal du client ou l’octroi de points à quelqu'un d'autre que vous. 

La procédure recommandée pour ajouter des « slots » client est de travailler à partir de 
l’interface de configuration de « FAHControl ». Ouvrez « FAHControl ». 

Passez en mode « Advanced » ou « Expert » en cliquant sur le bouton en haut à droite 
de l’écran et en sélectionnant « Advanced » ou « Expert » dans la liste déroulante (voir 
figure 1). L’interface de FAHControl se modifie.  

 
Figure 1 

Cliquez sur le bouton « Configure » (Configuration) en haut à gauche (voir figure 2). 

 
Figure 2 

La fenêtre de configuration apparait (voir figure 3).  

 
Figure 3 
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Sélectionnez l’onglet « Slots ». La liste des slots déjà configurés apparait (voir figure 4).  

 
Figure 4 

Cliquez sur le bouton « Add » (Ajouter). 

La vue « Configure Folding Slots » (Configuration d’un slot de pliage) apparait (voir 
figure 5).  

 
Figure 5 

Sélectionnez le type de « slot » à ajouter, « Uniprocessor » (Simple processeur), 
« SMP » ou « GPU ». Cochez le type de slot que vous voulez installer. 
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Aucune information complémentaire n’est nécessaire lors de l’ajout d’un slot 
« Uniprocessor ». 

Lorsque vous ajouter un slot SMP, il faut sélectionner le nombre de cœurs. 
Lorsque vous ajouter un slot GPU, la configuration recommandée est « -1 » de cette 
manière le client détectera automatiquement le type correct de carte graphique installée 
sur votre ordinateur.  

Cliquez sur « OK » pour continuer. La vue de l’onglet « Slots » réapparait avec le 
nouveau slot dans la liste (voir figure 6).  

 
Figure 6 

Répétez l’opération pour l’ajout d’autres slots ou cliquez sur « OK » pour finir la 
configuration et retourner à l’écran principal de « FAHControl ».  

Note : Le nouveau slot client utilisera les mêmes configurations de performance 
(pourcentage de CPU, fréquence des points de sauvegarde. etc.) comme définies dans 
l’onglet « Advanced ».  

Le nouveau slot chargera un nouveau calcul (WU) et commencera à plier.  
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6 Les fichiers de données 
Notez que l’emplacement des fichiers et dossiers dépendent du type d’installation que 
vous avez réalisée en fonction de votre système opératoire. La vue ci-dessous 
représente une installation par défaut sous Windows 7 64 bits où le chemin d’accès est le 
suivant : \Users\[Username]\AppData?\Roaming\FAHClient  

 
Ci-dessous un bref descriptif des fichiers et dossiers présent sur la vue du dessus :  

• « configs » Dossier où sont conservés les anciens fichiers de configuration des 
slots. Par défaut, il conservera un maximum de 16 anciennes configurations. 
(consultez la Note 4).  

• « cores »  Dossier où est placé les FahCores téléchargés.  
• « logs »  Dossier où sont conservés les anciens fichiers d’historique. Par 

défaut, il conservera un maximum de 16 anciennes configurations. (consultez la 
Note 4).  

• « work »  Dossier où se trouve le calcul (WU) téléchargé.  
• « config.xml »  Fichier contenant la dernière configuration des slots.  
• « FAHControl.db »  Fichier contenant la configuration de la fenêtre 

FAHControl.  
• « log.txt »  Fichier contenant l’historique en cours. Un nouvel historique sera 

créé à chaque redémarrage de FAHControl.  
• « sample-config.xml »  Fichier de configuration contenant les valeurs par 

défaut et donne un bref aperçu de la structure du fichier.  

Note 4 : Le nom de ces fichiers seront modifiés en ajoutant la date et l’heure en format 
GMT/UTC lorsqu’ils sont transférés dans ce dossier. Ci-dessous deux exemples :  

• config-20110115-173133.xml 
• log-20110123-205858.txt 

Nous ignorons les parties « log » et « config » qui restent les mêmes.  

Attardons-nous sur la première série de chiffres, « 20110123 » :  

• « 2011 »  Les quatre premiers chiffres donnent l’année  
• « 10 »  Les 2 chiffres suivants donnent le mois  
• « 15 »  Les 2 derniers chiffres donnent la date  

Maintenant ; analysons la deuxième série de chiffres « 205858 ». 

• 20 -> La première paire de chiffres donnent l’heure sous le format 24 heures  
• 58 -> La paire de chiffres du milieu donne les minutes  
• 58 -> La dernière paire de chiffres donne les secondes  
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7 Zone de notification 
Au lieu et place de réduire la fenêtre de FAHControl dans la barre des tâches, vous 
pouvez la réduire dans la zone de notification par un clique gauche sur l’icône de la zone 
de notification. Si vous voulez le revoir un simple clique gauche sur l’icône. Par un clique 
droit sur l’icône, un menu apparaîtra :  

 

• « Hide Window or Show Window »  Cacher/Ouvrir la fenêtre FAHControl. 
• « Fold »  Permet de démarrer tous les slots. 
• « Pause »  Met en pause tous les slots. 
• « Finish »  Permet de terminer le calcul (WU) en cours de chaque slot, 

d’envoyer les différents calculs (WUs) et de se mettre en mode pause. 
• « Viewer »  Consultez le chapitre « Visionneuse »  
• « Preferences »  Consultez le paragraphe « Préférences ». 
• « About »  Des informations concernant FAHControl. 
• Quit »  Arrêt de tous les slots et fermeture de la fenêtre FAHControl. 

En passant la souris sur l’icône, une petite fenêtre s’ouvrira vous donnant les 
informations suivantes :  

 

• « Name »  Votre pseudo en tant que membre de F@H.  
• « Team »  Le numéro de votre team.  
• « Status »  Donne le statut général de FAHControl qui peut être le suivant :  

o « Running »  Les slots sont actifs, i.e. les calculs (WUs) plient.  
o « Inactive »  Les slots sont inactifs, i.e. les calculs (WUs) ne plient pas.  
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